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BBS Edit is a plain text editor. It works just like Notepad , the Windows editor, but contains the 
following enhancements :
 

Multiple Document Interface, allows you to open more than one text files simultaneously.

Toolbar and Status Line, for easy access and explanation of common tasks.

Floating Toolbox, optionally, instead of Toolbar.

Unix to DOS conversion, converts Unix text files (frequently found on Internet) to DOS text 
files.

File Locator, searches any disk or path for a type of file      (wild cards supported ).

Page Options and True Type font support, allow you to print the file in various formats.

Recent File Memory, for easy opening of the last 10 files you have edited.

Read-in function, inserts contents of an existing file.

ANSI escape sequence insertion, for ANSI coloured graphic files.

Character Translation feature, for multilingual support.

Windows <-> DOS character set converter (Greek version only).

Signature insertion, for automatic signing of your e-mail.
 
For more information on the BBS Edit functions, please read the following topics :
 
The      Toolbar or Toolbox    ,      Print Preview        and the      File Locator
 
Inserting ANSI escape sequences      and      your signature
 
Using      the Menu    ,    Keyboard Shortcuts      and      Command line Options    
 
Multilingual Support      and      Special features of the Greek version
 
How to register BBS Edit !
 
Please note : This editor does not create backup copies of your files. It is advised that you create a backup copy of
any file before you edit it. As with most Windows text editors you are limited to editing 32 Kbyte files. You must use 
a word processor (such as Write) to work with bigger files. If you try to open a file with a size exceeding the 32 Kb 
limit, BBS Edit will automatically prompt you to open it in Write.



The Toolbar
 
A Toolbar or Toolbox is provided for easy access to the most common tasks. The following buttons
are available :
 

Creates a new text file

Opens an existing text file

Closes a window with a text file
 

Saves the text file to your disk (renames file with right click)

Converts Unix text file to DOS text file

Available only in the Greek version of BBS Edit
 

Cuts (moves) the selected text to the Clipboard

Copies the selected text to the Clipboard

Pastes text from the Clipboard at the insertion point
 

Reads-in (inserts) the contents of an existing file

Enables / Disables Character Translation feature

Inserts ANSI escape sequence
 

Inserts current date

Inserts current time

Inserts your signature
 

Opens the File Locator

Searches for a text string in your text file

Displays information on the file
 



Changes the display and printer font (supports various sizes, font types, TrueType)

Opens the Print Preview / Print dialog
 

Deletes the file from your disk. Use with caution
 
When the mouse pointer is placed over a button, you will read a short description of it's usage in 
the Status Line.
 
Please note :

 Most buttons will be disabled until you open a document. This is because the equivalent tasks 
can only be applied to open documents.

 You can select only one font setting for the display and printing of your document. When saved, 
your document will not preserve any font settings as it will be saved as a simple text file.



 ANSI Colour Graphics
 
MS-DOS comes with a driver called ANSI.SYS, which can be installed from your CONFIG.SYS file 
with a command such as DEVICE=C:\DOS\ANSI.SYS. Once installed,    ANSI terminal emulation of 
escape sequences is supported. An ANSI escape sequence is a sequence of ASCII characters, the 
first two of which are the escape character and the left bracket. With escape sequences you can 
change the display graphics, and add colour to your DOS environment. Here is an example of 
what can be achieved by using ANSI.SYS :
 

     
 

The first window shows your DOS prompt when set to PROMPT=$P$G. In the second window the 
DOS prompt has been changed to PROMPT=ESC[1;36;41m$p$gESC[0;37;40m (ANSI escape 
sequence). It means change the background colour to red, the foreground colour to cyan, set 
prompt to $P$G and then restore background to black and foreground to white. Although this is a
simple change, doing it manually is a very confusing task. This is what the ANSI code insertion 
facility is all about. By selecting Insert ANSI colour code from the Edit menu, or clicking on the 
ANSI button, the window shown on the right will appear. You can select the foreground / 
background / brightness / blinking options and insert automatically the appropriate code at the 
insertion point, by pressing the Insert button. You can insert the Clear Code (sets background to 
black, foreground to white as default) by pressing the Clear Code button. 
 
So, if you want to change your MS-DOS prompt, insert an escape sequence before $P$G and a 
clear code after it in your autoexec.bat file. Just remember, for the changes to take effect, you 
must reboot.



 File Locator
 
File Locator is a helpful utility for locating lost files. You can run it either from the File menu or by 
clicking on the File Locator button. The following window will appear :
 

 
If you want to find a file or file type you can enter a search criteria, using wild cards if necessary 
(for example *.TXT means any file with the TXT extension). Select a directory and File Locator will 
search this directory and all of it's subdirectories for the specified file or file type. If you select the
root directory (eg C:\) File Locator will search the entire disk. Once you have located the desired 
file, you can open it by double-clicking on it's name.



The Menu
 
File

File Locator Utility that locates a file or file type.
Open Recent Files The last 10 files you have edited are contained in a sub-menu for easy 
access.
 
Edit
 
Read-in file contents Inserts the contents of another existing file.
Insert ANSI escape sequence Opens the ANSI escape sequence insertion facility.
Insert Date Inserts the current date.
Insert Time Inserts the current time.
Insert Signature Inserts your text signature (for e-mail use).
 
Search
 
Find Looks for a text string in the open document.
Find Next Looks for the next appearance of this text string.
 
Options
 
Toolbar Toggles on/off the Toolbar.
Ruler Toggles on/off the ruler.
Status Bar Toggles on/off the status bar.
Window Colours Changes the Window colours (available White, Black, Blue)
Change Font Changes the screen and printer font.
Character Translation Enables/Disables the character translation feature provided for 
multilingual support.



Keyboard Shortcuts
 
You can use the following keyboard shortcuts with this editor :
 
Create New File Ctrl    + Ins
Open File Ctrl    + F12
Save File Shift + F12
Save File As ... F12
 
Cut Ctrl    + X
Copy Ctrl    + C
Paste Ctrl    + V
Delete Del
 
Read-in file contents Shift + Ins
Insert Date F5
Insert Time Ctrl + F5
Insert Signature Shift + F5
 
Find Text String Ctrl    + F
Find Next ... F3
 
Open Help File F1



Register BBS Edit...!
 

 BBS Edit is a shareware program. You are allowed to use and evaluate this fully functional free 
version, with no legal obligations whatsoever. You are also allowed (and urged) to copy and 
distribute this evaluation version by all means. If you find it useful and would like to reward the 
author's efforts, you are kindly requested to register by sending me $15 (only !). Of course I will 
accept the equivalent sum in any currency that can be exchanged. Don't forget to write your full 
name and address on your postal order or cheque (sorry, no credit cards accepted) . You will 
immediately receive your personal registration info, which will remove all the reminder screens 
and entitle you to upgrade to the next major release for free !!! ÅéäéêÞ ôéìÞ 
ãéá ôïõò ¸ëëçíåò ÷ñÞóôåò : 3.000 äñ÷ !!
 

 Please send your registration fee or any comments, bug reports and suggestions to my address 
shown on the right. You can also contact me by sending e-mail to my Internet address : 
ayan@hol.ath.forthnet.gr . If you would like to take advantage of BBS Edit's character 
translation feature, and include support of your language in the distribution zip file, please 
contact me to obtain further information. When installing BBS Edit, note that this program 
requires the presence of VBRUN300.DLL, CTL3D.DLL, CMDIALOG.VBX, MSGBLAST.VBX    and 
THREED.VBX    in your \WINDOWS\SYSTEM subdirectory and BBSEDIT.INI in your \WINDOWS 
directory.
 
I wish to thank Microsoft and other programmers for their freeware release of portions of this 
code, and also Antonio Cordero for his Help Pre-Compiler.
 
The author of this program gives no guarantee of it's functionality and cannot be held responsible for data loss or 
other damages related to the use of this program.



The floating Toolbox
 
You may use a floating Toolbox
instead of the Toolbar :

You can open it by dragging
                the Toolbar to a new position
                (within the form).

You can close it and return to
                the normal Toolbar by double
                clicking on it's mini control box.



The Greek character sets for DOS and Windows are different. This means that a text file created 
with a DOS editor is unreadable under Windows and vice versa. To cope with this problem, 
Pouliadis & Associates have created a special Character Set Conversion program which ships 
with the Greek version of Windows. This program, CONVERT.EXE, should be present in your 
Windows directory. BBS Edit uses a front end to this utility in order to assist you in converting 
between DOS and Windows text files. 
 
Please Note : If a file named CONVERT.EXE (such as the Metric Conversions program) exists in your path, then it 
may be run instead of the above specified file. Please check that your Windows directory is included in your 
autoexec.bat path statement before any other directory containing a file named CONVERT.EXE.



  Character Set Conversion
 
Available only in the Greek version of BBS Edit.
 
The Greek character sets for DOS and Windows are different. This means that a text file created 
with a DOS editor is unreadable under Windows and vice versa. To cope with this problem, 
Pouliadis & Associates have created a special Character Set Conversion program which ships 
with the Greek version of Windows. This program, CONVERT.EXE, should be present in your 
Windows directory. BBS Edit uses a front end to this utility in order to assist you in converting 
between DOS and Windows text files. By selecting the Windows/DOS conversion button, the 
following window appears :
 

 
Please Note : If a file named CONVERT.EXE (such as the Metric Conversions program) exists in your path, then it 
may be run instead of the above specified file. Please check that your Windows directory is included in your 
autoexec.bat path statement before any other directory containing a file named CONVERT.EXE.



    Multilingual Support
 
BBS Edit supports a feature called character translation, for languages that use special (accented 
etc) characters that differ from the normal Windows character set. Character translation is 
enabled from the Options Menu and requires the proper configuration of the file BBSEDIT.INI, 
found in your \WINDOWS directory. You must create a section titled [Translation] and enter any 
character codes you wish to translate. Let's see how this works. Suppose your BBSEDIT.INI 
contains the section :
 
[Translation]
122=156
 
This means that when you press a key whose ASCII character set code is 122 (the letter 'z' in the 
English Windows character set), this character will not be printed. In it's place will be printed the 
character with the ASCII code 156. By enabling character translation and creating a [Translation] 
section with the proper settings, you can produce foreign characters without any special 
keyboard drivers ! Of cource you will have to select a display font that supports the foreign 
character set. You will be prompted to do so automatically, when you enable character translation
from the Options menu.
 
You can toggle Character Translation On / Off fast by clicking on the button with your right mouse 
button. This enables / disables character translation without displaying the font selection dialog 
box.    You can also enable or disable character translation from the command line by running BBS
Edit with the /ON or /OFF options . In both cases the TranslationFont and NoTranslationFont 
(specified in the [FontSettings] section of    \WINDOWS\BBSEDIT.INI) are used. Defaults are 
Terminal and Fixedsys, but you can change these. The name of the font you specify must 
match the name you see in a font selection dialog box.
 
Example : Using character translation to translate the Windows character set to the DOS 
character set. Many foreign languages (including the Greek language) use different Windows and 
DOS character sets. You can use character translation to produce DOS character set based text 
files under Windows. These are the [FontSettings] and [Translation] sections of \WINDOWS\
BBSEDIT.INI needed to do this with the Greek character set :
 
[FontSettings]
NoTranslationFont= Fixedsys
TranslationFont=Terminal
 
[Translation]
127=160
161=039
162=234
163=035
164=042
165=089
166=124
167=036
168=034
169=067
170=097
171=034
172=219
173=045
174=082
175=196
176=248
177=241



178=253
179=051
180=039
181=163
182=219
183=250
184=235
185=236
186=237
187=034
188=238
189=219
190=239
191=240
192=228
193=128
194=129
195=130
196=131
197=132
198=133
199=134
200=135
201=136
202=137
203=138
204=139
205=140
206=141
207=142
208=143
209=144
210=219
211=145
212=146
213=147
214=148
215=149
216=150
217=151
218=136
219=147
220=225
221=226
222=227
223=229
224=232
225=152
226=153
227=154
228=155
229=156
230=157
231=158
232=159
233=160
234=161
235=162



236=163
237=164
238=165
239=166
240=167
241=168
242=170
243=169
244=171
245=172
246=173
247=174
248=175
249=224
250=228
251=232
252=230
253=231
254=233
 
When enabling such a translation, you will have to select a Windows font that supports the DOS 
character set, as the display font. One such font is the Terminal font.



 Insert your Signature
 
With BBS Edit you can automatically sign your documents, by using multi-line Text Signatures 
(very common on the Internet e-mail). Signatures are appended to the end of a file when you 
press the sign button. You can declare your own signature by creating a [Signature] section in the
file \WINDOWS\BBSEDIT.INI and inserting up to 9 lines of plain text labeled Line1, etc. Here is a 
simple example :
 
[Signature]
Line1=+---------------------------+
Line2=|        tarzan@jungle.africa      |
Line3=|              Demo Signature            |
Line4=+---------------------------+
 
This would of cource create the signature :
 
+---------------------------+
|        tarzan@jungle.africa      |
|              Demo Signature            | 
+---------------------------+
 
at the end of your text file, when the appropriate button is pressed.



Command Line Options
 
/NEW runs BBS Edit and opens a new text window
/OFF runs BBS Edit with no character translation 
/ON runs BBS Edit with character translation enabled
 
You can combine one of the /ON or /OFF options with the /NEW one
 
When Character translation is enabled / disabled from the command
line, BBS Edit uses the fonts specified in the [FontSettings]
section of BBSEDIT.INI (found in C:\WINDOWS). Defaults are :
NoTranslationFont= Fixedsys
TranslationFont=Terminal
 
Please note that BBS Edit maintains the /WIN and /DOS command line options for
 compatibility with the Greek version. Their use is identical to /OFF and /ON respectively.



 Print Preview
 
When you select the Print Preview button, the following dialog appears :
 

 
You can preview your document in a WYSIWYG    (what you see is what you get) window. 
WYSIWYG works better with TrueType fonts as these are scaled with very good precision. You can 
also select and setup a printer, jump from page to page and selectively print one or all pages.






